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1. Introducción: 
 
 
El presente documento incluye una guía primaria de uso más una traducción del archivo de 
ayuda (HLP) del programa original. 
La traducción es literal, motivo por el cual algunos datos o definciones ténicas me son 
desconocidas. 
Si bien la ayuda es bastante amplia, tenga en cuenta que esto no es un manual de usuario, 
motivo por el cual puede ser que, determinados temas, no se citen a fondo o se den por 
sobreentendidos. 
 
Cualquier comentario, agregado o modificación, será bien recibido. 
 

 

QRV, 
 
Daniel Magnoli – LW1DRJ 
ARM BBS, Moreno, B.A., Arg. (GF05OI) 
145.070 / 431125 / lw1drj.dyndns.org:6300 
http://www.lw1drj.com.ar 
lw1drj@lw1drj.com.ar 



 

Pequeña Guía Resúmen para Ansiosos 
 
 
2. Instalación: 
 
Radio Mobile no realiza modificaciones en el registro de Windows ni carga dll´s en los directorios 
del sistema. Solamente se deben descomprimir los zip en un directiorio exclusivo. 
Los archivos necesarios son: 
 
RMW761.ZIP  El ejecutable principal 
SUP.ZIP  Archivos complementarios 
NET.ZIP  Ejemplos de redes de comunicaciones 
VBRUN60SP6.EXE Rutinas de Visual Basic necesarias para la ejecución del programa. 
 
Una vez instalado el programa, verificar y crear si es necesario las carpetas o directorios DTED y 
SRTM, de modo que queden, por ejemplo, así: 
 
C: \ ARCHIVOS DE PROGRAMA \ RADIO MOBILE \ SRTM 
              DTED 
 
Nota: el de arriba es un ejemplo. Solamente es necesario respetar la ubicación y nombre de 
SRTM y DTED: ambas carpetas deben ser subdirectorios del principal. 
 

 
Los archivos mencionados mas arriba, se pueden bajar directamente de la dirección del 

autor, VE2DBE - Roger Coudé:  
 

http://www.cplus.org/rmw/english1.html 
 
 
 
3. Conceptos particulares: 
 
UNIT:  Estación de radio. 
SYSTEM: Especificaciones o parámetros de la estación de radio que definen su  

performance: altura de la antena, datos del equipo, etc. 
 
NETWORK: Grupo de estaciones de radio 
 
Radio Mobile requiere de mapas que tengan datos topográficos o de elevación sobre el nivel del 
mar para fijar en ellos las estaciones que se quieran analizar. La elevación en estos mapas, está 
dada por datos digitales (DTED o Digital Terrain Elevation Data). 
 
 
4. Primeros pasos – Seteos Básicos: 
 
Puede ocurrir que, al iniciarse el programa o para comenzar a definir nuestra primera red o 
network, se pidan tres parámetros iniciales: 
 
Number of Networks: Red. Por defecto es 25 pero podemos bajar a, digamos, 5 para mejorar  

la administración de memoria de la PC y para que sea mas fácil de leer 
la configuración.  

Number of Units: Estaciones. Por defecto es 50 pero podemos bajar. Idem anterior. 
Number of Systems: Nro. de equipos de la estación. Idem anterior. 



 
A continuación se setea la ubicación de los mapas tipo SRTM, para lo cual vamos a: Menú > 
Options > Internet > SRTM. 
 

1. Seleccionamos la opción “Download from Internet if a file is not found on a local path”.  
2. En “Local files path”, seleccionamos la ruta o directorio SRTM.  
3. En “Internet ftp directory, seleccionamos “USGS South América – 3 arcsecond”. 

 
El resto de las solapas queda sin modificar. Dar “OK” para salir. 
 
 
5. Obtención de un mapa: 
 
Los mapas se bajan de Internet, en la dirección de NASA mencionada mas arriba o de 
http://geoengine.nga.mil (National Geospatial Intelligence Agency – NGA Raster Roam).  
No es necesario acceder al ftp de la NASA para bajar mapas: lo hace el propio programa. 
 
Para tener nuestro primer mapa de referencia, vayamos a http://geoengine.nga.mil. Verán que la 
página no es muy amigable ni muy prolija, pero los datos son válidos… 
 
Una vez en la página: 
 

1. Bajar hasta “GEONAMES QUERY” y en “GEONAMES COUNTRY”, seleccionar 
“ARGENTINA” o el país que desées. 

2. Bajar hasta “STARTING CENTER POINT” y poner en “DEGREES MINUTES 
SECONDS”, la latitud y longitud de tu ciudad, respetando los cuadritos. Ese será el 
centro del mapa. El resto de los campos se deja como está. 

3. Picar el botón “Roam DMS”, bajo el cuadro “DEGREES MINUTES SECONDS”. 
4. Una vez que se dibuja la nueva pantalla, tendrás una imagen de Sudamérica con un “+” 

en la posición geográfica que ingresaste. 
5. En “AVAILABLE PRODUCTS LEVEL”, seleccionar “DTED Level 0” y en “Hgt”, 

seleccionar “MSL MTR”. El resto de los campos quedan como están. 
6. Dar clic en el botón “RASTER ROAM” y la pantalla se redibuja, mostrando ahora un 

mapa mucho mas chico, en blanco y negro de la zona elegida. 
7. Bajar por la pantalla hasta “RASTER EXPORTER” y picar en el vínculo.  
8. Aparecerá otra pantalla que dice “Run the Raster Exporter to download the native DTED 

over the viewed area”. 
9. Picar nuevamente en el botón “Raster Exporter” . 
10. Aparecerá una pantalla que dice “Raster Roam Requested Download File (U).  
11. Bajar hasta “Output File Download” y picar en el vínculo “rasexp_dted_.....zip”. Los nros 

intermedios son referencias al archivo. 
12. Cuando termine de bajar, borrar el archivo del servidor con el botón “Delete Download 

File”. 
13. Descomprimir con WINZIP el archivo bajado en el sub-directorio DTED de Radio Mobile. 

Se deberán armar varios directorios mas llamados “dted”, “w058”, “w059”, etc. 
 
Se pueden probar otras opciones como tamaño o nivel de DTED pero los resultados serán mas o 
menos los mismos, salvo el archivo final que será mas grande o pequeño. Nótese que el mapa 
obtenido tiene indicadas en pantalla, las coordenadas de los extremos del mismo. 
 
 
6. Inclusión del mapa dentro de nuestra red: 
 
Para que lo que bajamos se vea en la pantalla del Radio Mobil, vamos a Menú > File > Map 
Properties. 
 



1. En “Size (pixel)” ponemos 800 en “Widht” y 600 en “Height” 
2. En “Size (km)” ponemos 150 en “Height (km)”. Este valor representa el tamaño del mapa 

dentro de la pantalla. A mayor kilometraje, mas detalle de cobertura. 
3. En el cuadro “Centre”, picar el botón “Enter LAT LONG or QRA” 
4. Ingresar los datos de latitud y longitud que usamos para bajar el mapa. Para cambiar de 

N a S o de W a E, picar el botón correspondiente a la derecha del campo de ingreso de 
datos. 

5. Verificar en el campo “QRA”, que se cargue el locator correcto y dar OK. 
6. En “Elevation data source”, seleccionar “DTED” y picar la opción “Ignore missing files” al 

pié. 
7. Si no aparece la ruta del directorio en el cuadro “Drive or path…”, picar en “Browse” y 

localizar el subdirectorio DTED. 
8. Dejar el resto como está y dar clic en “Extract”. 
9. El mapa aparecerá en la pantalla. 
10. Si se desean ajustar detalles o tamaño entrar nuevamente a Menú > File > Map 

Properties y corregir lo necesario. 
 
El mapa es en colores y en la esquina superior izquierda, se pueden ver las referencias a las 
alturas sobre el nivel del mar. 
 
 
7. Aspecto del mapa: 
 
Se puede cambiar el aspecto del mapa entrando a Menú > File > New Picture. Ahí se puede 
pasar a blanco y negro, rainbow, o colores mas bajos como “colored slope (relative)”. 
Al cambiar de modelo, el mapa se redibuja con las muevas opciones. 
 
 
8. Intercalado de datos de ciudades (map points): 
 
Una vez que decidimos el aspecto del mapa, se podrán agregar los puntos de referencia al 
mismo: ciudades, rutas, etc. 
 

PARA CUMPLIR ESTE PUNTO DEBEREMOS ESTAR CONECTADOS A INTERNET !. 
CUIDADO CON LAS CONEXIONES DIAL UP YA QUE LOS DATOS PUEDEN SER PESADOS 

Y TARDAR BASTANTE… 

 
1. Vamos a Menú > Merge Pictures.  
2. Aparecerá un cuadro y en “Source”, seleccionamos “Internet Map Point”, luego, en “Map 

Point Selection” sleccionamos “”The World”. 
3. Dejamos el resto como está y picamos “Draw”.  
4. El programa comenzará a bajar los datos, viéndose el progreso de la carga en una barra 

de porcentaje al pie de la pantalla. 
5. Finalizada la carga, se dibujan los datos en la pantalla, sobre el mapa original y 

aparecerá un cuadro que pregunta si lo queremos guardar los datos en la imagen (“keep 
in actual picture”).  

6. Dar OK para guardar o  
7. “Do not Keep” para borrar. CUIDADO CON ESTA OPCION PORQUE LA IMAGEN 

BAJADA SE BORRARA Y HABRA QUE BAJARLA DE NUEVO !!!. 
 
Dando un clic en cualquier lugar de la pantalla, se presenta un cuadro que indica las alturas del 
terreno en esa posición (“elevation grid”). En el pie de la pantalla, se muestra la latitud / longitud 
en el punto donde está parado el cursor. 



 
9. Definiendo las estaciones de la red (UNITS): 
 
En este punto se cargan las estaciones de radio que compondrán una red. 
 

1. Entrar a Menú > File > Unit Properties 
2. En “Name”, colocar un nombre, p.ej. VHF, BBS, o el que se te ocurra. 
3. Picar el botón “Enter LAT LONG or QRA” y cargar los datos de la estación tal como se 

indica en el párrafo mas arriba (Inlcusión del mapa…). 
4. En el pie del cuadro, aparece el símbolo asignado por defecto. Recorrer con la barra 

deslizante para cambiarlo por el que se desée. 
5. Se deben cargar, por lo menos, dos estaciones por cada red (o network), PUEDEN 

ESTAR EN LA MISMA POSICION GEOGRAFICA SI SON LAS PROPIAS, PERO SE 
ENCIMARAN EN EL MAPA. 

6. Antes de poder ver la cobertura teórica, se debe definir la red 
 
 
10. Definiendo la red (o network): 
 

1. Entrar a Menú > File > Network Properties. 
2. Aparece el cuadro “Parameters” . En “Net Name”, ingresar un nombre, p.ej.: ARM BBS 

VHF. 
3. Ingresar los datos “Minimum frequency (mhz)”, p. ej. 145 y “Maximum frequency (mhz)”, 

p.ej. 148. 
4. En “Polarization” indicar “vertical” u “horizontal” 
5. El resto de los datos pueden quedar así, pero para que el análisis sea efectivo, se 

deberían revisar aspectos tales como pérdidas aidicionales que interfieran la señal 
(“City” o ciudad / edificios, “Forest” o bosque, etc.) y tipo de clima (“Climate”): marítimo, 
ecuatorial, desierto, etc. 

6. Picar en el botón “Membership” 
7. Seleccionar el primer equipo o “unit” y en el cuadro “Role”, seleccionar “command”. 
8. Seleccionar el segundo equipo y en “Role” seleccionar “Subordinate”. 
9. En todos los casos se debe definir un equipo como “command” y otro como 

“subordinate”. 
10. Picar en el botón “Systems” y abrir el desplegable “Select from radiosys.dat”. 
11. Elegir los parámetros para VHF o UHF según corresponda y corregir los datos según las 

característricas del equipo propio. 
12. Corregir “Antenna Gain” (ganancia de la antena) y “Antenna Height” (altura de la antena), 

según corresponda. 
13. En “list of all systems”, seleccionar “System 2” y hacer lo mismo, pero con, por ejemplo, 

los datos de UHF. Corregir si es necesario. 
 
 
11. Trazado de un area de cobertura: 
 
A esta altura, ya podemos trazar una cobertura teórica de nuestra estación. 
Seleccionar Menu > Tools > Radio Coverage > Single Polar 
Picar el botón “Draw”. 
“Redraw picture in gray mode”, pone el mapa en gris. Seleccionar NO si se quiere mantener el 
aspecto de color aunque en gris (gray mode), se aprecia mejor el area pero no tiene referencias 
de ciudades. 
 
Seguramente algo no les va a funcionar como quieren. Ver mas delante la explicación y 
conceptos ampliados de estos primeros pasos mas las mismas definiciones de datos pero 
con los lineamientos sugeridos por el autor. 



 

Traducción del Archivo de Ayuda 
 

 
NOTA 1: Se mantienen los nombres en inglés para reconocerlos dentro del Menú del 
programa agregando su descripción.  
 
NOTA 2: Se ha descompilado el archivo original con lo cual los temas se presentan de 
acuerdo al orden original dentro del mismo. 
 

 
 
Opciones del menú principal. 
 
File  (archivo) 
Edit   (editar) 
View  (vista) 
Tools  (herramientas) 
Options  (opciones) 
Window  (ventana) 
Help  (ayuda) 

 
 

Como hacer para: 
 
Acquire elevation data   (adquirir datos de elevación del terreno) 
Create a map picture   (crear una imagen de mapa) 
Position units    (unidades de posición) 
Create a networ    (crear una red) 
Save and retrieve projects  (guardar y recuperar proyectos) 
Perform radio coverage   (representar un area de cobertura) 
Perform visual coverage   (representar un area de cobertura visual) 
Import and scale user pictures  (importar y escalar imágenes de usuario) 
Create a flight animation  (crear una animación de vuelo) 
Export profile data   (exportar un perfil de datos) 
Use a local GPS and report position (usar un GPS y reportar una posición) 

 
 

Comandos Basicos 
 
Radio propagation model  (modelo de propagación) 
Radio link and system performance (vínculos y rendimiento de un sistema de radio) 
3D, panoramic, and stereoscopic views (vistas panorámicas, 3D y estereoscópicas) 
Geodesic, UTM, and MGRS coordinates (coordenadas geodésicas, UTM y MGRS) 
Keyboard and Mouse shortcuts  (atajos de teclado y ratón) 

 

 
File Menu (Menú Archivo) 
 
Network related group (Comandos relacionados a una red de estaciones) 
 
New networks   (Nueva Red de Estaciones) 
Borra todos los datos de la memoria RAM de la PC, imágenes y devuelve los valores por 
defecto a los parñametros que se hayan modificado. 
 



Open networks  (Abre un archivo que coniene las definciones de una red) 
Abre un cuadro de diálogo para cargar en memoria un proyecto de red definido con 
anterioridad. Este proyecto contiene units, redes y datos de sistemas. También contiene los 
mapas y sus ubicaciones dentro de la PC, éstos son cargados automáticamente al iniciar el 
programa o al recuperar un archivo de  proyecto. 
 
Save networks  (Guardar un proyecto) 
Abre un cuadro de diálogo para guardar el proyecto. 
 
Save networks as  (Guardar proyecto como) 
Abre un cuadro de diálogo para guardar el proyecto y sus datos con posibilidad de cambiar el 
nombre del mismo. 
 
Networks properties  (Propiedades de la Red) 
Abre un aventana que contiene los controles necesarios para crear una red (ver “Cómo crear 
una Red”) 
 
Unit properties  (Propiedades de una unidad) 
Abre un formulario para editar los datos de una unidad (ver “Como posicionar unidades) 
 
 
Map related group  (Comandos relacionados a los mapas) 
 
Open map    (Abrir mapa) 
Abre un cuadro de diálogo para cargar un mapa guardado previamente. El mapa contiene 
datos de elevación del terreno y se asocia, normalmente, a una imagen del tipo .BMP. 
 
Save map as   (Guardar mapa como) 
Abre un cuadro de diálogo para guardar los datos de un mapa como archivo. El nombre del 
archivo lleva la extrensión .MAP y contiene datos de elevación. Contrario a otras versiones de 
este programa, las imágenes de este tipo no se guardan porque se permitían múltiples 
imágenes por mapa. Cada imagen debe ser guardada con el comando Save picture as 
(Guardar imágen como) 
 
 
Map properties  (Propiedades de un mapa) 
Abre un formulario para definir la cobertura geográfica del mapa y seleccionar el tipo de base 
de datos de elevación (elevation database). Ver (Como adquirir datos de elevación) 
 
Previous map  (Mapa anterior) 
Abre el formulario de Map Properties  (Propiedades de mapa) con el centro y tamaño 
ajustados de acuerdo a parámetros cargados con anterioridad o en una versión anterior del 
mismo mapa. 
 
Next map   (Mapa siguiente) 
 
Abre el formulario de Map Properties  (Propiedades de mapa) con el centro y tamaño 
ajustados de acuerdo a parámetros cargados en otra versión del mismo mapa. 
 
 
Picture related group (Comandos relacionados a imágenes) 
 
New picture   (Nueva Imágen) 
 
Abre las Picture Properties (Propiedades de la Imagen) para crear una nueva imágen de un 
mapa. 



 
Open picture   (Abrir imágen) 
 
Abre un cuadro de diálogo para cargar una imágen de mapa desde el disco (archivos del tipo 
.BMP, .GIF, .TIF, .PNG o .JPG). Los archivos están asociados con archivos de propiedades del 
tipo .DAT. Si las propiedades del archivop no se localizan, la imagen es considerada como 
nueva y es escalada con datos manuales que deben ser ingresados en ese momento (Ver 
Import and scale user pictures (importar y escalar imágenes de usuario). 
 
Save picture as  (Guardar imágen cómo) 
 
Abre un cuadro de diálogo para guardar una imágen en los fomatos .BMP, .TIF, .PNG o JPG 
 
Picture properties  (Propiedades de imágen) 
 
Abre un formulario para crear o modificar un mapa. (Ver también Como crear una imagen de 
mapa. Como importar y escalar imágenes de usuario y Vistas 3D, Panorámicas y 
estereoscópicas (How to create a map picture_MDT51, How to import and scale user 
pictures1HHNKM, and 3D, panoramic, and stereoscopic views)). 
 
 
Print related group  (Comandos relacionados a la impresión) 
 
Print    (Imprimir) 
 
Imprime la imágen en sesión. La imagen es escalada y ajustada al tamaño de papel elegido. 
  
 
Program related  (Comandos relacionados al programa) 
 
Files list   (Lista de archivos) 
 
Muestra los archivos usados recientemente que pueden ser recargados. 
 
Exit    (Salida) 
 
Termina el programa, confirmación mediante.  



Edit Menu (Menú de Edición) 
 
Copy    (Copiar) 
 
Copia la imágen actual al portapapeles de Windows. 
 
Paste    (Pegar) 
 
Inserta el contenido del portapapeles en la imágen actual. 
 
Paste as a new picture (Pegar como nueva imágen) 
 
Crea una imágen en una nueva ventana. 
 
Merge pictures…  (Mezclar impagenes) 
 
Establece la selección de una fuente para ser mezclada con la imágen actual, mediante 
copiado, adición o multiplicación. La fuente puede ser otra imagen guardada y ubtenida de 
internet (LANDSAT (NASA), TerraserverUSA (sólo para USA), Tiger (sólo para USA), 
Toporama (sólo para CANADA), MapPoint o Mapquest. También puede ser ADRG 
(comprimido o no) o Land Cover. 
Usualmente se usará el servidor de NASA para obtener las referencias de ciudades y 
rutas. 
 
 
Draw grid…   (Dibujar cuadrícula) 
 
Abre un diálogo para ingresar datos de latitud y longitud o UTM sobre una imágen 2D. 
 
Draw rings…   (Dibujar anillos) 
 
Abre un diálogo para dibujar anillos de rango (de cobertura) sobre una imagen 2D. 
 
Draw objects   (Dibujar objetos) 
 
Selecciona Líneas (Lines), areas de relleno (Filled areas), etiquetas (Labels), ciudades 
(Cities) o todo (All) para agregar estos objetos en la imágen actual. 
 
Fit to a window  (Ajustar a pantalla) 
 
Crea una nueva imágen ajustada al tamaño de la pantalla. 
 
Rotate/Stretch  (Rotar / Estirar) 
 
Abre una ventana con entradas para ángulo de rotación y factor de estiramiento que pueden 
ser usadas para crear una nueva imágen o una activación del comando Aplicar (Apply). 
 
Flood   (Inundar) 
 
Inunda o completa los píxeles alrededor de la posicióon del puntero que tengan la misma 
elevación. 
 
Stratification   (Estratificación) 
 
Abre una ventana para colorear un tipo de elevación. 
 



Elevation contour  (Contorno de elevación) 
 
Abre una ventana usada para dibujar un contorno personalizado de acuerdo a intervalos de 
elevación del terreno. 
 
Force gray scale  (Forzar escala de grises) 
 
Modifica la imágen en colores y la pasa a escala de grises para utlizarla como fondo de un 
gráfico de cobertura. 
 
Shadow   (Sombra) 
 
Modifica una imágen para dibujar sobras entre montañas. 
 
Redraw last legend  (Redibujar última leyenda) 
 
Redibuja la última leyenda utilizada en el mapa. 
 
Distance scale  (Escala de distancias) 
 
Agrega una escala de distancias en el mapa. 
  
Corners coordinates  (Coordenadas de extremos) 
 
Muestra la long. / lat. de los cuatro extremos del mapa. 
 
Fit map to picture/selection (Ajustar mapa a la selección) 
 
Abre las Propiedades de Mapa (Map Properties) para extractar los datos de elevación de 
acuerdo con la imagen o selección. 
 
Fit map to units  (Ajustar mapa de acuerdo a estaciones de radio) 
 
Abre las Propiedades de Mapa (Map Properties) para ajustar en memoria la ubicación de todas 
las estaciones de radio definidas en el mismo. 
 
Orthorectify   (Ortorectificación) 
 
Dibuja una nueva imáagen la cual puede ser ajustada al mapa en forma exacta. 
 
Projection   (Proyección) 

 
Dibuja una nueva imágen de acuerdo a una proyección trapezoidal, lo cual ofrece menor 
distorsión. 



View Menu  (Menú Ver) 
 
Elevation grid  (Cuadrícula de elevación) 

 
Abre una pequeña ventana que muestra una cuadrícula de elevación intercalada de 5 en 5 con 
el centro en la posición del puntero. 
 
Find peak elevation  (Encontrar punto máximo de elevación) 
 
Ubica el cursor en la posición de máxima altura de acuerdo a los datos de elevación en 
memoria. 
 
World map   (Mapa Mundial) 
 
Abre una ventana con un planisferio de cobertura. 
 
Show networks  (Mostrar Redes) 
 
Inicia el trazado de rendimiento de todos los vínculos de todas las redes visibles. 
 
Hide networks  (Ocultar Redes) 
 
Ocultra el trazado de rendimiento y las referencias de estaciones de radio en todas las 
imágenes en memoria. 
 
Networks autoredraw (Redibujado automático de Redes) 
 
Si está selecconada la opción y la PC es rápida, el redibujado de la red se efectuará al cerrar 
la ventana de Propiedades de Red (Network Properties). 
 
Flight   (Vuelo) 
 
Abre la última animación de vuelo generada por el formulario de Radio Vínculos (Radio Link). 
 
Toolbar   (Barra de herramientas) 
 
Si está seleccionado, muestra los botones debajo de la barra de Menú. 
 
Status bar   (Barra de estado) 
 
Si está seleccionado, imágen, cursor y progreso de cálculos, se muestran en la parte inferior 
del formulario principal. 
 
Mouse coordinates  (Coordenadas de ratón o puntero) 
 
Si está seleccionado, se muestra constantemente la latitud y longitud del puntero del ratón. 
 
Full screen   (Pantalla completa) 
 
Maximiza la ventana activa al máximo de la pantalla. Si la imagen no entrase, usar los cursores 
del teclado para moverse hacia los puntos no visibles. 
 



Tools Menu (Menú Herramientas) 
 
Radio link   (Vínculo de enlace) 
 
Abre una pantalla que muestra los datos de perfil de la tierra, eficiencia del enlace y 
características de observación entre cada par de equipos de radio. 
  
Opens a form with a picture box that shows earth profile, radio performance, and observation 
features between each pair of units (Ver Radio link and system performance). 
 
Radio coverage  (Cobertura de Radio) 
 
Abre una pantalla pafra iniciar el trazado de cobertura en un mapa. (Ver How to perform radio 
coverage). 
 
Visual coverage  (Cobertura Visual) 
 
Abre una ventana para iniciar el trazado de la cobertura visual en el mapa. Ver How to 
perform visual coverage. 
 
Visual horizon  (Horizonte Visual) 
 
Abre un diálogo para inciar el trazado de datos al horizonte visual. 
 
HAAT   (HAAT) 
 
Abre un diálogo para calcular la altura promedio del terreno (Height Above Average Terrain). 
 
Network manager  (Administrador de Red) 
 
Abre un diálogo para ver la relación entre componentes de una red y cambiarlos si es 
necesario. 
 
Objects editor  (Editor de Objetos) 
 
Abre una ventana para editar archivos de objetos. 
 
Antenna pattern viewer (Visor de diagrama de irradiación de antenas) 
 
Abre una ventana para ver un diagrama de irradiación. 
 
Network Report  (Informe de Red) 
 
Abre una ventana para mostrar o imprimir una matriz de rendimiento de todas las redes 
definidas. 
 
Multicast Monitor 
 
Abre una pantalla que muestra los últimos mensajes recibidos y definidos en las Opciones de 
GPS (GPS Options). 
 
Metric conversion  (Conversor de medidas) 
 
Pequeño calculador de conversión de unidades de medida (millas / kilómetros o pies / metros y 
otras). Para pasar de un juego de medidas a otras, picar el botón “Units”. 
 



Options Menu (Menú de Opciones) 
 
GPS 
 
Abre un formulario para adquirir los datos de posición a través de un GPS por el puesrto serie 
de la PC e ingresar direcciones de internet a donde remitir esas direcciones. Ver How to use a 
local GPS and report position (Como usar un GPS local y reportar posición). 
 
APRS 
 
Abre un formulario para iniciar la recepción de APRS 
 
Internet 
 
Abre un formulario donde indicar al programa la dirección de internet donde ubicar los mapas 
SRTM, Toporama, Terraserver y Lansat. 
 
Elevation data (Datos de elevación) 
 
Abre un formularilo donde ingresar la ubicación desde donde se van a extractar los datos de 
elevación que se usarán para determinar los Radio Links y Rendimiento de Red (Network 
Performance). 
 
S-Unit  (Datos para Unidades “S”) 
 
Abre un formulario para ingresar las preferencias para las unidades S que se mostrarán en los 
Radio Links. 



 

Window Menu (Menú Ventana) 
 
Cascade  (Cascada) 
 
Reparte los mapas cargados en memoria en forma de cascada. 
 
Tile horizontal (Orden Horizontal) 
 
Reparte los mapas cargados en memoria en forma horizontal. 
 
Tile vertical  (Orden Vertical) 
 
Reparte los mapas cargados en memoria en forma vertical. 
 
Arrange icons (Acomodar Iconos) 
 
Alínea los íconos al pie de la pantalla. 
 

 
Help Menu  (Menú de Ayuda) 
 
Contents   (Contenido) 
 
Abre estas ayudas en inglés.. 
 
Search   (Búsqueda) 
 
Abre el índice de búsqueda. 
  
Check for web update (Chequear actualizaciones) 
 
Busca la últrima versión del programa en Internet.. 
 
About   (Sobre) 
 
Información sobre la versión del programa y el estado del sistema. 



How to acquire elevation data  (Como adquirir datos de elevación) 
 
 
Things to know first  (A saber primero) 
 
Maps    (Mapas) 

 
Los mapas están basados en una matriz de 2000 x 2000 registros de elevación (metros sobre 
el nivel del mar), los cuales se guardan en archivos con la extensión .MAP. Los datos de los 
distintos puntos de elevación y su altura s.n.m. pueden verse en la ventana Cuadrícula de 
Elevación (Elevation Grid) 
 
Terrain Elevation Data (Datos de elevación del terreno) 
 
Digital Terrain Elevation Data (MIL-D-89020 AMENDMENT 1). 
Los mapas están basados en el sistema DTED y el programa puede acceder a resoluciones de 
1, 3 o 30 segundos de arco: 
Los segundos de arco se definen como la separación entre registros del mapa según la 
siguiente tabla: 
 
1 segundo de arco (arcsecond)  30 metros 
3 segundos de arco    100 metros 
30 segundos de arco    1 kilómetro 
 
El programa puede tratar mapas de datos tipo GTOPO30, GLOBE y DTED Level 0 a 30 
segundos de arco, SRTM y DTED Level 1 a 3 segudos de arco, DTED Level 2, SRTM a 1 
segundo de arco y BIL en cualquier resolución. 
 
Usualmente se van a considerar mapas del tipo DTED Level 0 y SRTM. 
 
Interpolation   (Interpolación) 
 
Como los mapas son de dimensiones variables, la interpolación es necesaria para ajustar las 
bases de datos del programa. 
 
Deployment area  (Area de despliegue) 
 
El area de despliegue es una zona rectangular con coordenadas horizontales para para centrar 
la posición y fijar su tamaño en kilómetros lo suficientemente grande como para fijar todas las 
Units o estaciones de radio definidas. 
 
 
Step by step   (Paso a paso) 
 
1. En Menú > View, seleccionar World Map. En el mapa mundial que aparece, dar clic en la 
posición inicial deseada para obtener el centro del mapa a definir. 
 
2. En Menú > File, seleccionar Map Properties. Esta opción abrirá un formulario con los 
controles necesarios para crear el mapa. Dar un clic en el botón “Use Cursor Position”. 
 
3. Opcionalmente, usar “Select a city name” or “Enter LAT LON or QRA” para ingresar los 
datos en forma mas precisa. 
 
4. Seleccionar la base de datos asociada y su ruta dentro de los directorios de la PC. Si no se 
dispone de una base de datos, se puede obtener la misma seteando los parámetros de SRTM 



en las Preferencias de Internet (Menú > Options > Internet Preferences), para obtener los 
datos directamete del servidor. 
 
5. Seleccionar 400x400 pixels y 100 km en size. 
 
6. Dar click en el botón Extract. 
 
7. Si ocurre algún tipo de error, verificar las rutas de las bases de datos y comenzar de nuevo 
desde el punto 2.  
 
8. En Menú > File, seleccionar New Picture (ver Como crear una imágen de mapa) 
 



How to create a map picture (Como crear una imágen de mapa) 
 
 
Things to know first  (A saber primero) 
 
Picture size   (Tamaño de la imagen) 
 
El tamaño de la imágen es igual a la matriz de elevación definida en las Map properties y 
tiene directo impacto en la performance del programa. La cantidad de cálculos se incrementa 
en forma exponencial de acuerdo al tamaño de los lados. Se aconseja comenzar con tamaños 
de 400 x 400 píxeles e ir aumentando si es necesario. 
 
Video settings  (Ajustes en el video) 
 
El mejor compromiso es, definitivamente, 16bits (16-bit color setting) o 65536 colores. Algunas 
funciones tienen pobres resultados con resoluciones menores (8 bits o 256 colores). 
 
Draw mode   (Modo de trazo) 
 
Cada modo puede ser usado para mejorar las características visuales del terreno. El método 
mas común es el llamado Gray scaled slope o Escala de Grises ya que se ven mejor las 
características de los trazos de cobertura. 
 
 
About Picture properties (Sobre las propiedades de imagen) 
 
Gray scaled slope  (Escala de grises) 
 
Esta opción se usa para dibujar un mapa topográfico usando el color gris y sus subtonos, de 
acuerdo a las imperfecciones del terreno. En este modo, el mapa es dibujado utilizando un 
esquema de luces y sombras donde los puntos mas claros son los mas bajos del terreno, 
partiendo el foco de iluminación desde un extremo. Los terrenos planos van en gris neutro. 
Los ajustes de tono se pueden retocar en Menú > New Picture variando los valores de los 
cuadros “Contrast” (Contraste), “Brightness” (Brillo) y “Light Azimuth” (Inclinación del punto de 
iluminación). 
 
Colored slope (absolute) (Pendientes en colores (valores absolutos)) 
 
Esta opción es similar al gris pero con algunos colores que definen las alturas del terreno. 
La escala de colores es la siguiente: 

 
Rango de Elevación Color 
h < 0m    Magenta 
0m <= h < 100m   Cyan 
100m <= h < 300m  Green (Verde) 
300m <= h < 700m  Yellow (Amarillo) 
700m <= h < 1500m  Orange (Naranja) 
h >= 1500m   Gray (Gris) 

 
Colored slope (relative) (Pendientes en colores (valores relativos)) 
 
Similar a la anterior con algunas variantes en los rangos de elevación. Los colores son los 
mismos pero son escalados en forma distinta, con menos detalle. 
 
X-ray    (Rayos X) 
 



Similar a la escala de grises. En este modo el mapa es dibujado en relación a la elevación, con 
los puntos mas altos en gris mas oscuro y los mas bajos, en mas claro. La escala de grises se 
varía actuando sobre los controles Bottom elevation y Top elevation en las propiedades de 
nueva imagen (New Picture). 
 
X-ray (inverted)  (Rayos X – tonos invertidos) 
 
Similar a la anterior pero con los tonos invertidos: a mas altura, mas claro. 
  
Rainbow   (Arco Iris) 
 
Esta opción combina sombras y colores pre-definidos para producir una imagen de alta 
definición. Dando Clic en el botón “Colours” se pueden cambiar. 
 
Bottom elevation  (Menor elevación) 
 
Umbral de elevación mínima del terreno, en metros. 
 
Top elevation  (Mayor elevación) 
 
Umbral de elevación máxima del terreno, en metros. 
 
Contrast   (Contraste) 
 
Porcentaje de contraste. 
 
Brightness   (Brillo) 
 
Porcentaje de brillo de la imágen. 
 
Light Azimuth  (Inclinación o ángulo de iluminación) 
 
En grados, desde los cuales un foco de luz imaginaria, ilumina el terreno. 
 
10 meter contour intervals (Intervalos de contorno a 10 metros) 
 
Esta opción genera contornos de sombreado por cada 10 mts. de elevación. 
 
100 meter contour intervals (Intervalos de contorno a 100 metros) 
 
Esta opción genera contornos de sombreado por cada 100 mts. de elevación. 
 
500 meter contour intervals (Intervalos de contorno a 500 metros) 
 
Esta opción genera contornos de sombreado por cada 500 mts. de elevación. 
 
Draw objects   (Trazar Objetos) 
 
Esta opción muestra caminos, lagos, límites y etiquetas definidas en archivos del tipo .PLT 
(formato OziExplorer) que están localizados en un subdirectorio del programa, siempre y 
cuando se hayan definido en el mapa en forma manual. 
 
Show cities   (Mostrar Ciudades) 
 
En esta opción se muestran ciudades definidas en el archivo cities.dat si han sido inlcuídas en 
el mapa. Con el botón Font se puede definir traerlas adelante o detrás de la imagen actual. 



 
 
Step-by-step   (Paso a Paso) 
 
CREACION DE UNA NUEVA IMAGEN DE UN MAPA 
 
1. En  Menú > Filemenu, seleccionar New picture. (Nueva imagen) 
 
2. Seleccionar Grey scaled slope, 30% contrast, 70% brightness, 335 deg. Light azimuth, 
no Cities, y no Contours. 
 
3. Click en el botón Draw. 
 

NOTA: AL CREAR UNA NUEVA IMAGEN, NO SE REEMPLAZA LA QUE ESTA EN 
MEMORIA, SI ES QUE HAY ALGUNA, SINO QUE SE CREA UNA NUEVA VENTANA. 
AL SALIR DEL PROGRAMA SE PIDE CONFIRMACION PARA GUARDARLAS O 
DESCARTARLAS. 
 



How to position units (Como posicionar UNITS o estaciones de radio) 
 
 
Things to know first  (A saber primero) 
 
Cursor   (Cursor) 
 
El cursor tiene una posición horizontal con un registro de elevación en metros s.n.m., 
correspondiente a la intersección de las dos líneas punteadas que aparecen al hacer clic en 
cualquier punto del mapa. 
La Cuadrícula de Elevación (Elevation Grid), muestra formaciones de 5 x 5 elevaciones 
alrededor de la posición horizontal o del cursor en ese momento. Asimismo, se muestran al pie 
de la pantalla las coordenadas actuales. 
 
Elevation   (Elevación) 
 
Las UNITS o estaciones de radio, adquieren automáticamente una elevación (en mts. s.n.m.) 
del mapa cuando se las posiciona. También se puede entrar la elevación exacta manualmente. 
 
 
Enabled   (Activado) 
 
Esta propiedad determina si la estación está activa y/o visible en el mapa. Es útil para borrar 
temporalmente una referencia sin eliminar el objeto. 
 
Transparent   (Transparent) 
 
Opción que determina si el texto asociado es transparente o no. 
 
 
Step by step   (Paso a paso) 
  
1. Dar Click alternativamente en el mapa para elegir la ubicación de la estación de radio. 
 
2. En Menu > File seleccionar Unit properties. Este comando abre un cuadro con los 
controles necesario para posicionar la estación. 
  
3. Seleccionar una unit en la lista. 
 
4. Cambiar el nombre por el deseado. Dar Click en Place unit at cursor position para forzar 
la entrada de las coordenadas del cursor en la definición. 
 
5. Ajustar las propiedades visible,  transparent y backcolor. Observe los cambios en el 
ejemplo que se muestra debajo de la pantalla. 
 
6. Cerrar el cuadro Units properties. La etiqueta y dibujos definidos aoparecen en el mapa. 
 
 
Tip for repositioning   (Consejo para reposicionar) 
 
Parar el cursor o puntero del ratón y clickear en la posición deseada.  
Moverlo y dar click derecho en la etiqueta de la UNIT a cambiar. 
El programa pregunta si se quiere reposicionar la estación. Confirmar o descartar si no es 
correcto. 
De aceptar, la estación salta al nuevo lugar. 
Si se da doble-clic sobre el dibujito, se edita el cuadro Unit Properties. 



 
 

How to create a network (Como crear una Red de Estaciones) 
 
Things to know first  (A saber primero) 
 
ITS model  (Modelo ITS) 
 
El US Institute for Telecommunications Science (ITS) ha publicado un conocido modelo para 
radio-propagación comunmente referido como Longley-Rice Model. 
El código original en lenguaje Fortran ha sido traducido al formato de librería dinámica (.DLL) 
para Windows. La entrada del modelo incluye parámetros de entorno, sistema y datos 
estadísticos y la salida es el modelo de prediccón entre unidades o UNITS. 
 
Radio systems (Sistemas de radio o componentes de la estación) 
 
Hay algunos parámetros técnicos que se agregan al modelo ITS que deben ser seleccionados 
para computar la señal de recepción. El programa soporta hasta 25 configuraciones diferentes 
de equipos de radio que se pueden relacionar a la estación de radio en uso. 
 
Net topology  (Topología de la Red) 
 
El programa hace mas que evaluar la calidad de las comunicaciones entre puntos. Si se tiene 
seleccionada una topología de red donde se permiten las retransmisiones, el programa iniciará 
una interacción para encontrar la ruta mas corta entre los componentes de la red. Si no se 
encuentra una ruta viable después del máximo nro. de retransmisiones, el link propuesto de 
mostrará en color rojo.  
 
Net membership (Miembro de una Red) 
 
Cada Unidad o estación de radio en una red tiene un rol determinado y un sistema de equipos 
de radio. 
 
 
Net parameters (Parámetros de una Red) 
 
Net name  (Nombre de Red) 
 
El nombre de red puede tener hasta 30 caracteres de largo. 
 
Minimum and maximum frequency (Frecuencias mínima y máxima) 
 
Valores máximo y mínimo de frecuencias que componen la red. El programa toma el valor 
promedio entre ambas (o valor promedio del salto), para calcular el modelo de propagación. 
  
Polarization  (Polarización) 
 
Polarización de las antenas de cada sistema definido. 
  
Mode of variability (Modo de variabilidad) 
 
 
El modo Spot es para a one-try message. El modo Accidental evalúa las interferencias posibles 
de acuerdo al valor ingresado.. El modo Mobile es para estaciones que se están moviendo 
durante la transmisión. El modo The Broadcast es para estaciones fijas.  



El efecto de un porcentaje de tiempo, ubicaciones y situaciones depende del modo 
seleccionado. 
 
Surface refractivity (Refractividad del Suelo) 
 
La refractividad de la superficie del terreno es una medida que se toma en base a la 
refractividad del aire cerca o sobre la tierra. En general, el promedio de refractividad decrece 
con la altitud, comenzando con su valor máximo al nivel del mar. En ausencia de cualquier 
dato específico, se puede usar el valor por defecto indicado en la pantalla. 
 
 
Ground conductivity   (Conductividad del terreno) 
Relative ground permittivity  (Permeabilidad relativa del terreno) 
 
Estas propiedades determinan juntas la naturaleza de la reflexión de la onda de radio en la 
tierra aplicados a un link visual. En general, a mayor conductividad del terreno es mayor el 
riesgo de tener importantes atenuaciones o fluctuaciones en la señal de radio. El peor caso es 
del tipo “picket fence”. En ausencia de datos específicos, usar los valores por defecto que 
presenta la pantalla. 
 
 
Climate    (Tipo de clima) 
 
Esta opción es usada para seleccionar el tipo de clima encontrado mayormente en el area de 
despliegue y puede ser: 
 
Ecuatorial 
Continental Subtropical 
Maritimo Subtropical 
Desierto 
Continental Templado   (Continental Temperate) 
Maritimo Templado Sobre Tierra (Temperate over land) 
Maritimo Templado Sobre el Mar (Temperate over sea) 
 
Estas opciones ajustan algunos de los parámetros de cálculo en el algoritmo ITS usado en el 
programa. Las condiciones atmosféricas y el clima varían en diferentes lugares del mundo y 
afectan el índice de refracción en el aire y juegan un importante rol para determinar la fuerza y 
el fadding de las señales de radio. Por ejemplo, el gradiente del índice de refracción del aire 
cerca de la superficie de la tierra, determina el camino que sigue una onda de radio y la 
facilidad con que se desplaza a través de la atmósfera. 
El clima Continental Templado (Continental Temperate) es común a lo largo de las masas de 
tierra en la zona templada. 
 
Cancel    (Cancel) 
 
Restaura todas las propiedades de una red a sus valores iniciales de apertura. 
  
Default parameters   (Parámetros por defecto) 
 
Ajusta todos los parámetros del modelo de propagación a valores precargados. 
  
 
Systems    (Sistemas o Equipos de Radio) 
 
Predefined    (Predefinidos) 
 



Use esta lista para obtener los parámetros promedio del archivo radiosys.dat. Este archivo 
puede ser editado y corregido con el Notepad. 
Ejemplo: 
 

VHF  Name of the first installation (Nombre del equipo) 
50  Power in Watts   (Potencia) 
.25  Receiver threshold in microVolt (Umbral de recepción en Microvolts) 
.5  Line loss in dB   (Pérdida de la línea en dB) 
.8  Antenna gain in dBi  (Ganancia de la antena en dBi) 
2  Antenna height in meters (Altura de la antena en metros) 
 
UHF  Name of the second installation (Nombre de otro equipo… 
20  Power in Watts   (datos… 
.5  Receiver threshold in microVolt (datos… 
1.5  Line loss in dB   (datos… 
4  Antenna gain in dBi  (etc. 
2.5  Antenna height in meters ( 
... 

 
Transmit power   (Potencia del transmisor) 
 
En Watts. Ingreso manual. 
 
Receiver threshold   (Umbral de recepción) 
 
En Microvolts. Ingreso de acuerdo al manual del usuario del equipo. 
  
Line loss    (Pérdida de la línea) 
 
Pérdida de la línea de transmisión en dB. Ingreso manual. 
 
Antenna gain   (Ganancia de la antena) 
 
En dBi (ganancia relativa sobre una antena isotrópica). Ingreso manual. (Para traducir datos de 
un dipolo a una antena isotrópica, sumar 2.2 dB) 
 
Antenna height   (Altura de la antena) 
 
En metros, desde el suelo. Entrada manual. 
  
 
Net topology    (Topología de la Red) 
 
Visible    (Visible) 
 
Usar esta opción para mostrar u ocultar una red en el mapa. 
 
Voice net    (Red de Voz) 
 
Usar esta opción para una red donde se necesiten lineas de enlace desde puntos fijos o 
principales (command post) a equipos complementarios o subordinados (subordinate), pero no 
entre equipos subordinados entre sí. La retransmisión entre estaciones puede ser usada para 
incrementar el rango de comunicación. 
 
Data net, star topology  (Red de datos. Topología tipo estrella) 
 



Use esta opción para definir una red de datos donde un equipo maestro sondea equipos 
suplementarios que no se comunican entre sí. 
 
Data net, cluster   (Red de datos.  Grupo) 
 
Use esta opción para una red con nodos que retransmiten datagramas (rebroadcast, 
digipeating). 
 
Maximum number of rebroadcasts.  (Nro. máximo de retransmisiones) 
 
Si se deja en cero, este parámetro inhibe la retransmisión, cualquier otro valor, fija el nro. de 
retransmisiones según el cálculo (Maximum number of rebroadcasts) = (Time to live) - 1 
 
 
Net membership    (Miembros o componentes de una red) 
 
List of all units    (Lista de todas las unidades o estaciones) 
 
Usar esta opción a la izquierda de la lista para agregar o borrar unidades a la red. Seleccione 
un rol (command o principal / subordinate o secundario) y un sistema (o equipo de radio), para 
cada unidad (o estación de radio) definida en la lista de la izquierda. Para verificar el rol y el 
sistema asignados a una unidad, dar click en el nombre de kla unidad en “List of all units”. 
 
 
Member role and system   (Rol del componente y sistema) 
 
Cuando se incluyen estaciones en una red, se deben agregar algunos parámetros técnicos. 
Estos parámetros están reagrupados bajo la misma definción de sistema o equipo de radio 
para reducir el uso de memoria. Si se agrega a una estación un parámetro que difiere de otras 
de la misma conmdición, un nuevo sistema o equipo de radio debe ser definido. La única 
excepción es la altura de las antenas, que puede ser la misma para todos. 
 
 
Style (Applies to all nets)   (Estilo (Aplica a todas las redes) 
 
Propagation mode    (Modo de propagación) 
 
Cambia entre modo de propagación Normal o Inteference. Para estudios de interferencia, el 
modelo es optimista… 
 
Network drawing colors   (Colores de trazado) 
 
El usuario puede seleccionar distintos colores y umbrales de tonos para los trazados. 
 
 
Step by step     (Paso a paso) 
 
1. Seleccionar Menú > File > Network properties. 
 
2. Picar el botón Parameters. 
 
3. Use la List of all nets para seleccionar una red a editar. 
 
4. Cambiar el net name y ajustar todos los parámetros de propagación requeridos  
 
5. Picar el botón Topology. 



 
6. Activar Visible y seleccionar Voice net topology. 
 
7. Picar el botón Systems. 
 
8. Use la lista List of all systems para seleccionar y configurar todos los equipos que sean 
necesarios para armar la red. 
 
9. Picar el botón Membership. 
 
10. Seleccionar las unidades que quiera que estén en la red. Para cada unidad, se deberá 
seleccionar un rol y un sistema.. 
 



How to save and retrieve projects (Como guardar y recuperar 
proyectos) 
 
 
El archivo de red (*.net) incluye: 
Parámetros de radio-propagación, topología y membresía para 25 redes (máximo) en 
memoria. 
Datos técnicos para 25 sistemas de radio (máximo) en memoria. 
Propiedades para 50 unidades (máximo) en memoria. 
Nombre del archivo de mapa. 
Nombre de las imágenes. 
Altura de las antenas para las que difieran de los datos por defecto asignados por el sistema. 
 
Step by step  (Paso a paso) 
 
1.Guardar la matriz de elevación primero con Save map as 
 
2. Guardar cada imágen individualmente con Save picture as 
 
3. Guardar la red y datos de unidades con Save networks as 
 
4. En Menú > File, seleccionar New networks para borrar todos los datos en memoria. 
 
5. En Menú > File, seleccionar Open networks para seleccionar un archivo de red guardado 
anteriormente. 
 
6. Verificar que todos los datos e imágenes se hayan recuperado normalmengte. 
 

 
How to perform radio coverage (Como representar un esquema de 
cobertura de radio) 
 
Things to know first  (A saber primero) 
 
Radio coverage of what?  (Cobertura de radio de que??) 
 
Hay que suponer que una unidad es estacionaria mientras que la otra se mueve alrededor de 
ella. 
Los parámetros del sistema son los mismos que los vistos en Radio link, excepto aquellos que 
son para representar la posición de la unidad móvil. 
 
Performance to meet  (Rendimiento a localizar) 
 
El programa usa un umbral de recepción en unidades S, en microvolts, dBm o microvolt/m. El 
umbral de rendimiento en unidades S es relativo a la sensibilidad del receptor, mientras que los 
otros toman la “entrada” al mismo receptor. (Ver Radio link and system performance) 
 
Single Polar    (Polar simple) 
 
La superficie es cubierta acorde a coordenadas polares alrededor del centro de la estación. El 
rango y ángulo azimutal o su incremento, pueden ser ajustados. 
 
Combined Cartesian   (Cartesiano Combinado) 
 



La cobertura es dibujada con a pequeños cuadritos de tamaño variable en píxeles. Muchos 
lugares pueden ser usados para producir cobertura combinada con la mejor señal disponible 
en cada posición en el mapa. 
 
Interference    (Interferencia) 
 
El gráfico se hace también con cuadritos de tamaño variabla. La cobertura de un transmisor 
puede ser mostrada en dos colores: el primero muestra el rango normal de acuerdo a la 
mínima señal a encontrar, mientras que el segundo color indica que una señal de un segundo 
transmisor es interferida. La interferencia se detecta cuando la mínima señal coincide con el 
promedio de interferencia. 
 
Rendering 
 
El area de dibujo y los contornos de señal pueden ser seleccionados. El color de la cobertura 
se mezcla con la imágen del mapa con el operador lógico “and”. La mejor resolución requiere 
mas recursos de la PC. 
 
Antenna pattern   (Patrón de antena) 
 
Si se usa una antena no direccional como centro de la unidad, la antena (o su gráfico), será 
apuntado automáticamente a la dirección correcta. La orientación puede ser cambiada 
variando los datos de azimuth (antenna azimuth text box). 
 
 
Step by step    (Paso a paso) 
 
1. Crear una imágen de mapa en el modo “gray slope” 
  
2. Posicionar la unidad central (center unit) (ver How to position units) 
 
3. Ingresar los parámetros de red (network parameters) para el centro de la unidad y su móvil o 
dependiente (ver How to create a network) 
 
4. En Menú > Tools, seleccionar Radio coverage y Single Polar 
 
5. Seleccionar adecuadamente la unidad central / dependiente y su red. 
 
6. Seleccionar el umbral de 1 a 11 unidades S, el rango radial o distancia a medir (radial range) 
de 0 to 100 km, el rango de azimuth (azimuth range) de 0 deg. a 360 deg. a 1 deg. step. 
 
7. Seleccionar en Plot el Fill area con color amarillo (yellow). 
 
8. Picar el botón Draw. 
 

 
How to perform visual coverage (Como representar un esquema de 
cobertura visual) 
 
Things to know first  (A saber primero) 
 
Applicability   (Aplicación) 
 
La cobertura visual se usa para medir o linealizar en el acto, un rango de intercepción o radar. 
Esto se basa solamente en parámetros geométricos del espacio libre, tomando en cuenta la 



altura del sensor sobre el suelo, la altura del blanco sobre el piso, la topografía y la curvatura 
de la tierra. 
 
Earth radius   (Radio terrestre) 
 
La cobertura visual (Visual coverage), usa el promedio del radio terrestre para simular la 
curvatura del planeta. Esto explica la diferencia observada con la cobertura de radio normal 
(Radio Coverage), donde la onda de radio tiende a doblarse. 
 
 
Step by step   (Paso a paso) 
 
1. Crear una imágen de mapa en el modo “gray slope” 
 
2. Posicionar la unidad central (center unit) (ver How to position units) 
 
3. En Menú > Tools seleccionar Visual coverage 
 
5. Seleccionar adecuadamente la unidad central / dependiente y su red. 
 
6. Seleccionar el rango radial o distancia a medir (radial range) de 0 to 100 km, el rango de 
azimuth (azimuth range) de 0 deg. a 360 deg. a 1 deg. step. 
 
7. Seleccionar en Plot el Fill area con color amarillo (yellow). 
 
8. Picar el botón Draw. 
 

 
How to import and scale user picture (Como importar y escalar 
imágenes de usuario) 
 
 
Things to know first  (A saber primero) 
 
Valid source   (Fuente de datos válidos) 
 
El programa maneja archivos BMP. GIF y/o JPG, de satélite, escaneados de un mapa, etc. 
 
Calibration   (Calibración) 
 
Una imágen debe ser calibrada para ser usada entrando la latitud y loingitud correcta de sus 
cuatro esquinas. 
 
 
Step by step   (Paso a paso) 
 
1. En Menú > File, seleccionar Open picture. 
 
2. Seleccionar una imágen que no esté relacionada a ningún mapa. 
 
3. Activar la ventana de esa imágen y en Menu > File, seleccionar Picture properties. 
 
4. Ingresar los datos de lat. / long. para cada una de las esquinas del mapa. 
 
5. Presionar el botón OK. 



 

 
How to create a flight animation (Como crear una animación de vuelo) 
 
Things to know first  (A saber primero) 
 
Flight path   (Ruta de vuelo) 
 
El vuelo sigue una línea directa entre la antena de Tx y la de Rx. 
 
Disk space   (Espacio en disco) 
 
La simulación de un vuelo usa una enorme cantidad de memoria de disco. Es muy prudente 
importar todas las imágenes dentro de un programa de animación de video que las comprima 
antes de usarlas, tal como “GIF Constructor”, por ejemplo. 
 
 
Step by step   (Paso a paso) 
 
1. En Menú > Tools seleccionar Radio link 
 
2. Si se muestra un link válido, ir a View y a Observe. 
 
3. Use las Options para especificar el nro. de marcos por segundo y la velocidad del vuelo. 
 
4. Seleccionar Create normal flight. 
 
5. Después que se completa, ejecute la animación en modo real con View flight or Flight en la 
opción View 
 

 
How to export profile data  (Como exportar un archivo de perfil) 
 
Things to know first    (A saber primero) 
 
Export file format    (Formato de archivo) 
 
El programa puede exportar datos de un perfil a un archivo de texto, de modo que pueda ser 
utilizado por Notepad u otro programa similar. 
 
 
Rmpath program    (Programa RMPATH) 
 
Rmpath es un simple programa freeware que puede ser usado para ver lo exportado por Radio 
Mobile. Si este programa está en el directorio de la aplicación principal, se puede abrir 
directamente despues de grabar el archivo exportado. 
 
 
Step by step     (Paso a paso) 
 
1. En Menú > Tools seleccionar Radio link 
 
2. Si se muestra un link válido, ir a Edit y a Export to…. 
 
3. Abra Notepad to ver el archivo de perfil creado. 



 

 
How to use a local GPS and report position (Como usar un GPS 
local y reportar posición) 
 
 
Things to know first   (A saber primero) 
 
GPS serial output   (Salida serie del GPS) 
 
Muchos GPS´s son capaces de enviar información a través de un puerto serie. Sólo los pines 
TXD y GND son necesarios para conectar al PC. El GPS debe estar configurado a 4800 o 
9600 bds, 8bits, No Parity, 1 stop bit. 
 
GPS sentence recognized  (Sentencia de GPS reconoicida) 
 
El programa busca una sentencia que comience con la sentencia $GPRMC desde el GPS. 
Esta sentencia es común a muchos GPS´s. 
 
UDP protocol   (Protocolo UDP) 
 
El programa usa el protocolo Multicast UDP para reportar una posición a otra PC mientras está 
corriendo el programa. Este protocolo es común a muchas LAN´s y puede ser usado en 
Internet, siempre y cuando la dirección IP (o nombre de dominio o computer ID), sean válidos. 
 
 
Step by step    (Paso a paso) 
 
1. En Menú > Options, seleccionar GPS options 
 
2. Ingrese el puerto serie donde esté conectado el GPS. 
 
3. Ingrese la unidad a mover. Esta es la unidad que se moverá de acuerdo a la posición 
recibida en el GPS. 
 
4. Ingrese la dirección IP y puerto a los cuales se reportará la posición. 
 
5. Presione Ok para inciar la decodificación local del GPS. El punto de color en la barra de 
estado empezará a titilar como señal de actividad.. 
  
6. Si la opción Log está activa, las sentencias serán guardadas en un archivos. Use Play back 
para verificar. 
 



Radio propagation model (Modelo de Radio Propagación) 
 
Introduction  (Introducción) 
 
Este software es una herramienta para ayudar en la elaboración de redes de radio 
comunicaciones. Antes de implementar una red en el campo, se puede usar paa verificar el 
rendimiento de los distintos links. 
 
El programa evalúa si un link de radio es posible entre dos puntos dados y provee el 
rendimiento estimado teniendo en cuenta: 
 
a. Las características de los equipos de radio empleados,  
 
b. La teoría de propagación de ondas de radio, utilizando el modelo de predicción del US 
Institute for Telecommunications Science (ITS), mejor conocido como Longley-Rice model 
(Notas 1 and 2)). 
 
Nota 1 Georges A. Hufford, Anita G. Longley and William A. Kissick.  A Guide to the Use of the 
ITS Irregular Terrain Model in the Area Prediction Mode, National Telecommunications and 
Information Administration (NTIA) Report 82-100, US Department of Commerce, April 1982. 
 
Nota 2 Anita G. Longley.  Radio Propagation in Urban Area, Institute of Telecommunication 
Sciences, Office of Telecommunications, Boulder, Colorado 80302. 
 
 
Suggested values for surface parameters (Valores sugeridos para parámetros de 
superficie) 

 
(Tipo de suelo) (Conductividad) (Permeabilidad relativa) 
Ground attribute Ground Conductivity Relative Permittivity 
 
Average ground 
(Tierra promedio) .005 15 
Poor ground 
(Tierra pobre) .001 4 
Good ground 
(Tierra buena) .02 25 
Fresh water 
(Agua fresca) .01 25 
Sea water 
(Agua de Mar) 5 25 
 



Radio link and system performance (Links de radio y rendimiento del 
sistema) 
 
Radio link menu bar  (Barra de menú Radio Link) 
 
Edit    (Editar) 
 
Use Copy para enviar una copia de la imágen activa al portapapeles. 
Use Export to... para guardar un archivo de perfil y abrir el programa RMPATH. 
 
View    (Ver) 
 
Use Profile para iniciar la ejecución de la extracción del archivo de perfil y el calculo de 
rendimiento entre las unidades seleccionadas en las listas de la izquierda y derecha. 
Cambiando unidades en cualquier lista o cambiando la red (en el medio de la lista), se iniciará 
el mismo proceso. La unidad de la izquierda transmitirá datos hacia la de la derecha. 
Use Swap para intercambiar Tx y Rx entre units. 
Use DetaiIs para generar un corto informe de rendimiento, tal como distancia, azimuth, modo 
de propagación y datos de sistemas. 
Use Range para ver la señal y la relación con la distancia. El cursor es posicionado en la 
distancia donde la señal no encuentra el rendimiento requerido. 
Use Distribution para ver la distribución estadística relativa al rendimiento del receptor. 
Use Observe y seleccione cualquier ángulo de visualización para observar la unidad de la 
derecha respecto de la izquierda. 
 
Profile picture  (Archivo de perfil) 
 
Clickeando en la imágen del perfil moverá el receptor a lo largo de la ruta. La etiqueta indica la 
distancia, espacio libre u obstrucción y señal. El símbolo 0.6F1 significa 0.6 veces la primera 
zona de Fresnel. 
 
S-meters   (Unidades S) 
 
Cada una de las luces verdes corresponden a una unidad S, las luces rojas, a un adicional de 
10 dB sobre S9. El S-Meter de la derecha corresponde a la señal recibida para una transmisión 
de izquierda a derecha. El S-Meter de la izquierda al contrario. Los valores pueden diferir si la 
ganancia de los sistemas son diferentes en cada caso. 
 
 
Radio link performance (Rendimiento de un link de radio) 
 
La performance de un link de radio se calcula en: 
 

T (dBm) = 10 log10 (potencia del tx en Watts) + 30  
L1 (dB) = Pérdida de la línea de transmisión 
A1 (dBi) = Ganancia relativa de la antena respecto a una isotrópica 
P (dB) = Pérdida típica del modelo Longley-Rice (incluyendo margin de fadding   

requerido) 
A2 (dBi) = Ganancia de la antena de recepción con respecto a una isotrópica 
L2 (dB) = Pérdida de línea en el receptor 
R (dBm) = 20 log10 (Umbral de recepción en in microvolts) - 107 



El rendimiento se muestra en dB: 
 

M (dB) = Señal de recepción (dBm) - R (dBm) 
M (dB) = (Tx - L1 + A1 - P + A2 - L2 ) - R 

 
El rendimiento se muestra en unidades S para frecuencias < 30 MHz:  
 

S0  (M <= -3dB) 
S1 (M > -3dB and M <3dB) 
S2 (M >= 3dB and M <= 9dB) 
S3 (M > 9dB and M < 15dB) 
S4 (M >= 15dB and M <= 21dB) 
S5 (M > 21dB and M < 27dB) 
S6 (M >= 27dB and M <= 33dB) 
S7 (M > 33dB and M < 39dB) 
S8 (M >= 39dB and M <= 45dB) 
S9 (M > 45dB and M < 54dB) 
S9 + 10 (M >= 54dB and M < 63dB) 
S9 + 20 (M >= 63dB and M < 73dB) 
S9 + 30 (M >= 73dB and M < 83dB) 

 
El rendimiento se muestra en unidades S para frecuencias >= 30 MHz:  
 

S0  (M <= -1.5dB) 
S1 (M > -1.5dB and M <1.5dB) 
S2 (M >= 1.5dB and M <= 4.5dB) 
S3 (M > 4.5dB and M < 7.5dB) 
S4 (M >= 7.5dB and M <= 10.5dB) 
S5 (M > 10.5dB and M < 13.5dB) 
S6 (M >= 13.5dB and M <= 16.5dB) 
S7 (M > 16.5dB and M < 19.5dB) 
S8 (M >= 19.5dB and M <= 22.5dB) 
S9 (M > 22.5dB and M < 27dB) 
S9 + 10 (M >= 27dB and M < 39dB) 
S9 + 20 (M >= 39dB and M < 49dB) 
S9 + 30 (M >= 49dB and M < 59dB) 

 
 
3D, panoramic, and stereoscopic views (Vistas 3D, panorámicas y 
estereoscópicas) 
 
3D picture  (Imágenes 3D) 
 
La imágen 3D es una opción disponible en las Picture Properties. Se usa una imagen de 
mapa en 2D como fuente para el color de los píxeles, cada píxel de la imagen 2D corresponde 
a un polígono en la 3D. Los polígonos llenan los espacios entre píxeles despues de la 
transformación geométrica. El ángulo de vista puede ser acomodado con las scroll bars en las 
3D Picture Properties. Las imágenes 3D se usan para mostrar las redes tal como son: 
Networks elevation puede ser modificada sin tener que redibujar la imagen usando el 
comando Show nets. 



Stereo  (Stereo) 
 
La imágen estereoscópica es también una opción disponible en las Picture properties. Esta 
usa una imagen 2D como fuente para los colores y cubre el mismo area que la 2D, salvo que 
usa separación de colores, que se ven con anteojos 3D… 
 
 
Observation view (Vista de observación) 
 
La vista de observación está disponible después de una extracciópn de datos de perfil en la 
ventana de Radio Link. El ángulo de visión se puede ajustar para acercar la imagen. El punto 
de observación es de Tx a Rx. Los círculos blancos y negros se dibujan cuando la antena de 
Rx es visible. 
 
Stereo view  (Vista Stereo) 
 
La observación estereoscópica es similar a la vista estereoscópica. 
 

 
Geodetic, UTM, and MGRS coordinates  (Conceptos de Coordenadas 
Geodésicas, UTM y MGRS) 
 
WGS 
El sistema World Geodetic System (WGS) se usa para definir la posición horizontal de una 
estación. En el programa, los rangos de latitud de 90° Sur a 90° Norte y longitud 180° Oeste 
(W) a 180° Este (E). 
 
UTM 
Universal Transverse Mercator (UTM) divide la tierra en 60 zonas de 6 grados de longitud. El 
punto norte (Northing) es la distancia desde el Ecuador (m) mientras que el punto este 
(Easting) es la distancia desde la longitud central de la zona (m) mas 500.000. 
 
MGRS 
El sistema Military Grid Reference System (MGRS) deriva del UTM. 
 

Ejemplo de MGRS: 
13S CF 94000 48000 o 13S CF 940 480 o 13S CF 94 48 significa: 

Zona    13S 
100 000 m square  CF 
Easting    94000m 
Northing   48000m 

 



Keyboard and Mouse shortcuts (Atajos de teclado y ratón) 
 
Tecla 
F1 Help - Ayuda 
ESC Stop / Cierra ventana / Cancel 
ALT-F4 Salir del programa 
PG UP Muestra imágen previa 
PG DOWN Muestra próxima imágen 
CTRL-1,  CTRL-2, … Cambia imágenes 
CTRL-C Copia la imágen o selección al portapapeles 
CTRL-F Encuentra la cumbre en una selección o imagen 
CTRL-I Dialogo de Picture properties 
CTRL-M Herramienta de conversion 
CTRL-N Networks Properties 
CTRL-O Abre una network 
CTRL-P Print 
CTRL-S Save network 
CTRL-U Units Properties 
CTRL-V Pega el contenido del portapapeles en una imagen nueva 
Keyboard arrows Mueve cursor 
+ Aumenta la elevación del cursor en una imagen stereo 
- Disminuye la elevación del cursor en una imagen stereo 
 
Mouse click 
CTRL-botón izq en icon Select left site of Radio Link 
CTRL-botón der en icon Select right site of Radio Link 
SHIFT-Button on icon Select a unit for Combined Radio Coverage 
SHIFT-Button on a text box Bring the metric conversion tool (if applicable) 

 
FIN del Archivo de Ayuda. 
 


